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Getting Started

Important Notes!

Hardware Exchange

If you use local HELiOS licenses and want to exchange any hardware components, modify the partitioning of, or
re-install the operating system, you need to revoke the existing license on the HELiOS workstation first, and
request, using the new hardware or modified configuration, a new license key (further information on the pro-
cedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in case
of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new hard-
ware.

Discontinuation of HELiOS 32-Bit and HiCAD Viewer 32-Bit

As of HELiOS 2022 (Version 2700.0), a 32-Bit version for HELiOS and the HiCAD Viewer will no longer be avail-
able. However, the interface to 32-Bit applications such as Office will still be possible and is not affected by the
discontinuation of the 32-Bit installation of HELiOS.

Discontinuation of Oracle

As of HELiOS 2022 (Version 2700), Oracle will no longer be officially supported as a database system! Please
migrate to a SQL Server as soon as possible.

Discontinuation of Mircosoft Office 2010 interface

From HELiOS 2021 (Version number 2600.0) on, we will no longer support Office 2010 in the HELiOS – Office
interface.

Discontinuation of old Multi-CAD interfaces for HELiOS 2022

As of HELiOS 2022 (Version 2700.0), the following versions of Multi-CAD interfaces are no longer supported:

n AutoCAD (Mechanical) 2018

n Inventor 2018

n Navisworks 2018

HELiOS
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Discontinuation of the ISD.PDM.API

Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022 omwards,
the previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.Interface. If you use
customisations that use functionalities from the previous ISD.PDM.API, you must update the customisations to
the new API before carrying out the HELiOS update. If you use customisations that use functionalities from the
HiCAD API, you should ensure that the HiCAD version used is at least version 2502.5 or 2601.1 or newer. If you
are unsure whether you are using corresponding adaptations, please talk to your administrator or contact the
ISD in case of doubt.

Discontinuation of Windows® 7 and Windows® 8

Microsoft® has discontinued support for the Windows® 7 operating system in January 2020. For compatibility
reasons, HiCAD 2020 SP2 and HELiOS 2020 SP2 were the last versions of our CAD or PDM system to support
Windows© 7. HiCAD 2021 and HELiOS 2021 no longer run under Windows© 7, Windows© 8 and the cor-
responding server operating systems (Windows Server 2008 R2, Windows Server 2012 and older) are also no
longer supported. If an attempt is made to install HiCAD 2021 or HELiOS 2021 on a computer with Windows©
7 or Windows© 8, a message appears.

Data compatibility

When performing a HELiOS update, the update start mask shows you the HELiOS subversion, which needs to
match the existing database. If this is not the case, only an error message will appear when you start HELiOS.
To update the database schema, use the program HeliosDbUpdate.exe. If the database schema requires an
update, you can no longer access the database with older HELiOS versions. Therefore, all workstations access-
ing the database need to be readjusted accordingly at the same time.

Update HELiOS

In the context of HELiOS Update Installations, the last 5 release cycles are supported. As of HELiOS 2022 (Ver-
sion 270*.*), you can only update installations from 2017 (Version >= 2200.0) and newer. (See also Carrying
out the installation.)

PDF preview in the HELiOS Desktop

Please note that the PDF preview in the HELiOS Desktop no longer works with Acrobat Reader DC from Version
2021.011.20039.

As an alternative, we recommend using Foxit Reader. Before installing it, you must uninstall Acrobat Reader
DC. You may also have to adjust the configuration file hel_preview.ini if Acrobat Reader was explicitly defined
for PDF preview there.
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New Mask Editor in HELiOS 2020

Due to the complete revision of the Mask Editor in HELiOS 2020, the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in some
changes in the system architecture that Administrators must consider:

n The masks of older versions (before V 2500.0) that were previously stored in the SYS directory of the install-
ation are automatically converted to the new XML format in case of an update installation and stored at
%Programdata%.

n The new masks at %Programdata% should not be overwritten under any circumstances, as these rep-
resent the "delivery status", which will be updated by later update installations. If masks are edited and
changed with the Mask Editor, you must store and call them at %Appdata%.

Updating the HELiOS-Inventor interface

For an update of the Inventor interface from an older HELiOS version to HELiOS 2020 (Version 2500) or higher
(and the corresponding update of the database schema) the following changes have to be considered:

1. The structure identifiers for Inventor parts must be updated.

2. The standard part and semi-finished product identifiers are changed to a document-based (instead of art-
icle-based) management.

An update installation can only be carried out after an appropriate preparation of the migration.

In case of an update, please contact the Consulting team of the ISD Group. New installations of HELiOS 2020
and the associated database are not affected.

Updating the HELiOS-SOLIDWORKS interface

For an update of the SOLIDWORKS interface from an older HELiOS version to HELiOS 2020 (Version 2500) or
higher (and the corresponding update of the database schema) the following changes have to be considered:

Since a migration of the configuration IDs is performed during the update, an update installation can only be
performed after the migration has been prepared accordingly. In the event of an update, contact the Consulting
team of the ISD Group. New installations of HELiOS 2020 and the associated database are not affected.

Attribute mappings: Conversion of the default mapping

With HELiOS Major Release 2022 (V. 2700) an adjusted standard attribute mapping is delivered. By converting
the mapping for designating component names to configuration-specific attributes, a significant performance
increase was achieved when loading SOLIDWORKS assemblies.

Existing mappings, which are generally not changed by an update installation, should be updated to the new
standard manually. Please refer to the HELiOS Online Help.

HELiOS
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Important update notes for attribute mapping in title blocks

Until HELiOS 2019, attribute mapping at SOLIDWORKS was done by the following files:

n heliossw_titleblock.dat (attributes for the title block),

n helios_cs_global_config.dat (attribute mapping/presetting in both directions),

n sw_comp_name.dat (display in the model tree in CAD).

As of HELiOS 2020 (Version 2500.0), the mapping must be set up again manually. No migration tools exist.

Up to HELiOS 2019, the attribute for the title block in AutoCAD was created using the following files:

n heliossac_titleblock.dat,

n helacblock.xml

As of HELiOS 2020 (version 2500.0), the mapping must also be set up manually here.

In case of an update, please contact the Consulting team of the ISD Group.

Important notes for administrators during a HELiOS update installation working with the HELiOS integ-
ration for Inventor, AutoCAD and SOLIDWORKS!

When updating the database to HELiOS 2019 Service Pack 2 or higher, the old workspace is checked for doc-
uments in progress. These are documents with the pen symbol in the respective (old) workspace dialog, or
entries of locked documents in the Workspace Manager from HELiOS Desktop (on the right hand side).

Should the check find relevant documents, the following message appears:

The update of the database cannot be performed because there are still locked documents in old local work
areas which will not be supported in the future. After this update, only work areas with new administration are
supported and automatic migration is not possible. More information can be found here.

HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You should make sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path %appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.

Units for attributes when working with the HiCAD-HELiOS interface

If you work with the HiCAD-HELiOS interface and want to use interface-relevant units for attributes, then you
must work with HiCAD 2022 (V 2700) or higher.
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Omission of the system files KSTEXT_STDKOP.DLL and TEILHOST_NEXT.EXE

As of HELiOS 2022 (V. 2700), the system file KSTEXT_STDKOP.DLL and the executable file TEILHOST_
NEXT.EXE are omitted. Customer-specific adjustments to your system, in which these files were used, must
therefore be adjusted again.

Please contact the Consulting team of the ISD Group.

Operating system

We recommend deactivating local licenses and network licenses before performing an update/upgrade of the
operating system (e.g. from Windows 8 to Windows 10), and activating them again after successful update/up-
grade of the operating system.

Discontinuation of old figure format (FIG)

The following notes regarding FIG-FGA conversion are unnecessary if HELiOS is used in conjunction with the
HELiOS Vault Server.

Since HiCAD 2017 we support FGA as figure format (before that FIG). From HiCAD/HELiOS 2021 or HELiOS
2021 as an update for HiCAD 2019/2020 onwards, we require that all figures stored with HELiOS have been
converted to the new FGA format beforehand. To convert existing 2-D FIG files, the tool Converter_FIG_To_
FGA.exe is available in the exe directory of the HiCAD installation.

If there are still unconverted FIG files in the HELiOS document database at the time of the database update to
HELiOS 2600.0, you will be informed of the outstanding conversion of these files before the database update. In
this case, the conversion must be carried out before or at the latest directly after the update using Converter_
FIG_To_FGA.exe.

HELiOS
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System Requirements for the HELiOS Database Server
The requirements with regard to the hardware primarily depend on the specifications given by the respective
RDBMS supplier (Microsoft). Currently, following operating systems are supported:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Microsoft SQL Server 2019

Microsoft SQL Server 2017

Microsoft SQL Server 2016

Microsoft SQL Server 2014

Microsoft SQL Server 2012

Microsoft SQL Server 2008

Microsoft SQL Server 2005

In addition, the following minimum requirements should be guaranteed for the main memory and hard disk:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Main
memory

Additionally at least 4 GB main memory.

With an increasing database size the working memory should be enlarged in order to guarantee
optimal performance.

Hard disk Additionally at least 10 GB hard disk memory.

The actual demand depends on the size of the database.

Please note:

n The use of virtual servers is essentially possible. Please consider to grant sufficient performance within the
virtual environment.

n On the database server, HELiOS data base should be imported beforehand, for example via HELiOS Data-
base Creator, so that clients can connect with the database.

n SQL Server Standard vs. SQL Server Express
As of late, the productive use of SQL Server Express is possible. Please note that SQL Express has limited
storage size (10 GB) for each data base and provides weaker performance than SQL Standard, especially
on powerful hardware. If well-equipped hardware is used for the server (multiple processors and plenty of
RAM), the SQL server thwarts the performance again. On regular desktop hardware the difference between
SQL Express and SQL Standard is smaller due to the accordance of express limits and system.

HELiOS
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System Requirements for the HELiOS Vault Server
The minimum requirements are as follows:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Processor
(CPU)

64 Bit processor

Main memory Additionally at least 1 GB main memory

Hard disk The required hard disk space depends on the volume of arising data use (files). A safety mar-
gin should be considered.

Operating sys-
tem

Microsoft Windows 10 or Microsoft Windows Server 2016 or higher

Windows Server 2012 (R2) is supported from Vault Server Version 2601.1 or higher.

Please note:

n If you work with only interfaces to HiCAD and/or Microsoft Office, the use of HELiOS Vault Servers is
optional. Other interfaces must be used in conjunction with the HELiOS Vault Server.

n The needed hard disk space can also be distributed on multiple volumes.

n We recommend the use of RAIDs in order to ensure failsafe performance.

12 / 146 Installation Notes

System Requirements



System Requirements for the HELiOS Client
The HELiOS Desktop (Client) is installed as 64-Bit application. The minimum requirements are as follows:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Processor (CPU) 64 Bit processor

Main memory Additionally at least 2 GB main memory

Hard disk Additionally at least 2 GB free hard disk memory

Operating system Microsoft Windows 10 or Microsoft Windows Server 2016 or higher

The interfaces that are available for the HELiOS Clientare listed in a Compatibility Matrix.

Please note:

n When interfacing the HELiOS Desktop with other applications, for instance with a CAD system or Office
product, please consider the minimum requirements of each system manufacturer.

n If you want to use an integrated viewer, the hardware requirements of respective viewer manufacturer must
be considered.

n Before you can use the HELiOS Client you require a HELiOS Database Server as well as an appropriately
configurated ODBC connection.
Documents (in .pdf format) describing the installation procedure for the database system and the import
and export of the database can be found in the Wiki.

Compatibility Matrix for Interfaced Applications (HELiOS)
Below you find a list of possible interfaces for the HELiOS Client:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Operating system

Windows 11, 64 Bit (as of SP1)

Windows 10, 64 Bit

Windows 8.1

Windows 8

Windows 7

Server Operating system

Windows Server 2022 (as of SP1)

Windows Server 2019

Windows Server 2016

CAD system

HELiOS
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HELiOS 2022 HELiOS 2021 HELiOS 2020

HiCAD 2022

HiCAD 2021

HiCAD 2020

HiCAD 2019

HiCAD 2018

HiCAD 2017 or older

AutoCAD 2023 (as of SP2, Patch 1) (as of SP1, Patch 4)

AutoCAD 2022 (as of SP1)

AutoCAD 2021 (as of SP1)

AutoCAD 2020

AutoCAD 2019

AutoCAD 2018

AutoCAD 2017

AutoCAD 2016

AutoCAD 2015 or older

AutoCAD Mechanical
2023

(as of SP2, Patch 1) (as of SP1, Patch 4)

AutoCAD Mechanical
2022

(as of SP1)

AutoCAD Mechanical
2021

(as of SP1)

AutoCAD Mechanical
2020

AutoCAD Mechanical
2019

AutoCAD Mechanical
2018

Inventor 2023 (as of SP2, Patch 1) (as of SP1, Patch 4)

Inventor 2022 (as of SP1)
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HELiOS 2022 HELiOS 2021 HELiOS 2020

Important:

*As of Inventor version 2021.1 (or newer) can be used from HELiOS Version 2502.3 or 2600.1. The
reason for this is the bug in Inventor described here. 

Inventor 2021* (as of SP1)

Inventor 2020

Inventor 2019

Inventor 2018

Inventor 2017

Inventor 2016

Inventor 2015 or older

Navisworks 2022 (as of SP1)

Navisworks 2021 (as of SP1)

Navisworks 2020

Navisworks 2019

Navisworks 2018

Navisworks 2017

Navisworks 2016

Navisworks 2015

SOLIDWORKS 2022 (as of SP1) (as of SP1, Patch 4)

SOLIDWORKS 2021 (as of SP1)

SOLIDWORKS 2020

SOLIDWORKS 2019

SOLIDWORKS 2018

SOLIDWORKS 2017

SOLIDWORKS 2016

SOLIDWORKS 2015 or
older

CAE-SYSTEM

HELiOS
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HELiOS 2022 HELiOS 2021 HELiOS 2020

EPLAN Electric P8 2022 (as of SP2, Patch 1) (as of SP1, Patch 5)

EPLAN Electric P8 2.9

EPLAN Electric P8 2.8

EPLAN Electric P8 2.7

EPLAN Electric P8 2.6

EPLAN Electric P8 2.5

EPLAN Electric P8 2.4

Zuken E3 2021 (as of SP1)

Zuken E3 2020 (as of SP1)

Zuken E3 2019

OFFICE

Office 2021 (as of SP1)

Office 2019

Office 2016

Office 2013

Office 2010

Office 2007 or older

The symbol does not always mean that the respective product is not compatible. It can also mean that the inter-
actions between this product and the HELiOS Client have not been sufficiently tested by the ISD yet.
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System Requirements for the HELiOS Internet Server
For the HELiOS Internet Server, similar system and hardware requirements as for the HELiOS Desktop apply:

HELiOS 2022

Processor
(CPU)

64 Bit processor

Main memory Additionally at least 4 GB main memory

Hard disk Additionally at least 2 GB free hard disk memory

Operating sys-
tem

Microsoft Windows 10 or Microsoft Windows Server 2016 or higher

Others As a prerequisite for the installation of a HELiOS Internet Server, a HELiOS Client must be
installed beforehand.

Operation via SSL (https) requires valid certificates for the corresponding web pages of the
HELiOS Internet Server.

The Microsoft Internet Information Server (IIS), at least version 10.0 with ASP.NET 4.8 support, is also required.This
is an integral part of Windows, but must be installed/activated separately before installing the HELiOS Internet
Server.

Proceed as follows:

Choose Control Panel > Programs and Features and, at the top left of the window, select Turn Windows features on
or off. In the Windows Features dialogue window, choose Internet Information Services > Web Management Tools,
and Internet Information Services > World Wide Web Services > Application Development Features and activate
the checkboxes as shown below:

HELiOS
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Please note:

n Besides IIS, HELiOS Client (HELiOS Desktop) must be installed.

n IIS URL Rewrite from https://www.iis.net/downloads/microsoft/url-rewrite must be installed.

n For the operation of the HELiOS Internet Server, a (sub)domain including a valid SSL certificate and port for-
wardings are required.

n To operate the HELiOS Internet Server, a number of website configurations in the Internet Information
Server (IIS) are required. Parallel operation with other websites/products on the IIS is not recommended.
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System Requirements for the HELiOS Spooler
Generally, the HELiOS Spooler is a 64 Bit application. The main memory should be at least as large as the main
memory for the utilized Client systems. This ensures that all data to be processed by the HELiOS Spooler (i.e. the
data transmitted from the Client systems to the HELiOS Spooler can be handled successfully.

HELiOS 2022 HELiOS 2021 HELiOS 2020

Processor (CPU) 64 Bit processor

Main memory Additionally at least 2 GB main memory

Hard disk Additionally at least 4 GB free hard disk memory

Operating system Microsoft Windows 10 or Microsoft Windows Server 2016 or higher

Please note:

n The HELiOS Spooler runs on a separate Plot Server system. It is not possible to install the HELiOS Spooler
together with the HELiOS Desktop on the same system! Reasons for this are, for example, possible dif-
ficulties with the Office interface, since both the HELiOS Desktop and the HELiOS Spooler install Word and
Excel customizations. It is also not recommended to use the system on which the HELiOS Spooler is run-
ning as an occasional workstation. This is partly because it is assumed that the HELiOS Spooler is the only
instance of the system that starts print jobs.

n The HELiOS Spooler requires locally installed CAD, electrical engineering or Office applications for that plot
and conversion orders are carried out. Please note that the use of these applications requires respective
licenses and that the hardware requirements of each system supplier must be considered as well.

n The main memory should be at least dimensioned as large as the main memory of the client system
deployed. Thus it is guaranteed that the data (which is transferred from the client systems to HELiOS
Spooler) can be processed accordingly.

n Besides the client operating systems for Windows, the above mentioned server operating systems can be
used as well. It depends on the license terms for the Microsoft OS used by your company whether a server
operating system can be used or not. Here, the number of permitted simultaneous connections is deciding
here.
For Windows 10, 20 simultaneous logins are approved. In this case, you need to assure that apart from the
current logins sufficient logins are available for each Client computer’s Print Client.

HELiOS
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System Requirements for the License Server
We use the Software Sentinel RMS© from gemalto© for licensing. The license server is in principal a 32 Bit applic-
ation.

The minimum requirement for running a license server is as follows:

HELiOS 2022 HELiOS 2021 HELiOS 2020

Processor (CPU) X86 or AMD64 Architecture.

Recommended: 2 GHz Processor

Main memory Additionally at least 1 GB main memory

Hard disk Additionally at least 2 GB free hard disk memory

Operating system Microsoft Windows 10 or Microsoft Windows Server 2016 or higher

Windows Server 2012 (R2) is supported from License Server Version 2601.1 or higher.

Please note:

n The license server need not be installed on a separate server or server operating system.

n A static IP address is required for the correct operation of a license server. When using a virtual server, a
static MAC address is required.

n The license server must not be installed on the same computer with HELiOS Desktop, because both
products share system information with regards to the licensing.

n Internet access is needed for the license server due to activation and deactivation.

20 / 146 Installation Notes

System Requirements



System Requirements for the HELiOS Application Server
Please contact our consulting in terms of hardware requirements and installation of HELiOS Application Server.

HELiOS
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Operation in Virtual Environments

HELiOS Client

Generally, the HELiOS Client can be operated on Virtual Machines (VM). If you use integrated viewers, the hardware
requirements of the respective viewer manufacturer must be considered.

The HELiOS Client can also be used as a terminal application.

HELiOS Spooler

Generally, the HELiOS Spooler can be operated on Virtual Machines (VM). However, limitations may occur with
regard to simultaneously installed CAD system, electrical engineering software or Office applications.

With regard to graphics functionality, performance and integration of printers, too, limitations may occur in virtual
environments.

License Server

The license management system based on Sentinel RMS© by the company gemalto© can, generally, also be used
in virtual environments.

Network licenses on Virtual Machines (VM)

If you want to use/activate/deactivate the network licenses on virtual machines, please observe the following points:

n A static MAC address is required

n A static IP address is recommended or required when using Commuter Licenses

n Before copying or changing a virtual machine, deactivate the network licenses, since the UUID (Universal
Unique IDentifier) of the VM will change due to the copying process, and cannot be deactivated afterwards any
more. This also applies to the starting of the VM on a different host.
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Further Requirements for Installation
n Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer before

HELiOS can be used; these packages will be installed as part of the HELiOS installation if required.

n To be able to work with HELiOS, a database system must be available that has been prepared for HELiOS. For
this you require

l A Microsoft SQL Database Management system on your Server,
l A HELiOS database imported with the HELiOS Database Creator and
l An ODBC connection on the Clients.

Documents (in .pdf format) describing the installation procedure for the database system and the import and export
of the database can be found in the Wiki.

HELiOS
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Installation
The installation medium (e.g. ISO file from the Download area) contains the installation files for:

n HELiOS Database Creator (required when creating a HELiOS database for the first time, and for importing or
exporting an existing database)

n HELiOS Vault Server

n HELiOS Client (HELiOS Desktop, Standalone)

n HELiOS Help

n HELiOS Internet Server

n HELiOS Spooler

n EPLAN Article Synchronization

n Postscript printer driver (required for the output of multiple views in a PDF file)

Important note on the scope of installed modules!

The scope of modules that will be installed depends on the product that was purchased. This means that not all
modules described in the installation manual may be included in your software version.

It is mandatory for the installation of HiCAD to start the setup.exe file from the root directory of the ISO file; only in
this way it is ensured that the version will recognize the operating system, and that the matching HELiOS version will
be installed.

Please note:

n You can conveniently download the current HELiOS version in the Download Area of the ISD Wiki.

After running the setup.exe file, the following dialogue will be displayed:
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Leave this selection mask open, so that you can select the desired components one after the other.

Discontinuation of Windows® 7 and Windows® 8

Microsoft® has discontinued support for the Windows® 7 operating system in January 2020. For compatibility reas-
ons, HiCAD 2020 SP2 and HELiOS 2020 SP2 were the last versions of our CAD or PDM system to support Win-
dows© 7. HiCAD 2021 and HELiOS 2021 no longer run under Windows© 7, Windows© 8 and the corresponding
server operating systems (Windows Server 2008 R2, Windows Server 2012 and older) are also no longer supported.
If an attempt is made to install HiCAD 2021 or HELiOS 2021 on a computer with Windows© 7 or Windows© 8, a
message appears.

HELiOS
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Installing the HELiOS Database Creator
The HELiOS PDM modules (Document management, Part Management, Workflow etc.) are based on a relational
database. Before you put HELiOS into operation, the Microsoft SQL Server database administration system needs to
be installed on the server, a HELiOS database needs to be imported and a ODBC connection needs to be set up on
the clients.

When you set up a HELiOS database for the first time, the HELiOS Database Creator needs to be installed and
executed on the database server first. The database and table structures will then be created, and filled with data
records of the HELiOS standard database.

Please note:

Further information about the correct procedure for the execution of the HELiOS Database Creator, as well as
the previous and subsequent steps required for the setting up of a database server can be found in the user
guide for the installation of the Microsoft SQL Server. You can find this document in the ISD Wiki.

Start Windows to install the HELiOS Database Creator. If Windows has already been started, close all other applic-
ations and start the installation wizard.

Leave this selection mask open, so that you can select the desired components one after the other.

Click on the HELiOS Database Creator button.
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Select an installation directory for the HELiOS Database Creator and click Next.

HELiOS
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Click Install to start the installation.

Click Finish to complete the installation of the HELiOS Database Creator. If desired, you can now install further com-
ponents via the selection mask.
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Installing the HELiOS Vault Server
Please start Windows to install the HELiOS Vault Server. If Windows is already open, end all other applications and
start the Installation Wizard.

This screen remains open so that you can install the required components one after another.

Please note:

In rare cases, a manually installed older version of the Vault Server may be found which is not touched
(updated) by the setup for safety reasons. In case of an error message, please contact our hotline staff. E-Mail:
support@isdgroup.com

Click on the Vault Server button.
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Enter the installation directory for the Vault Server. If the installation wizard finds an already installed version, it will
be offered to you for updating.
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Give the Vault Server a name, e.g. the name of your company, plus the location of your company. This name will be
shown, for example, when you connect to the Vault Server from the Vault Client.

The Vault Server renames all documents that are managed in the database (e.g. SZA, DOC, XLS, …) to *.VDF.
These VDF files are saved to the Document directory.

The files stored in the Management directory contain the assignments of the VDF file names to the “original file
names”.

HELiOS

Installation Notes 31 / 146



Log files (*.LOG) are saved to the Log directory. They record each access to the VDF files.

Enter the name of the log file in the Log file name field. The name of the Vault Server would also be possible here. If
the log file exceeds a certain length, it will be cut down and suffixed by the current date.

Click Install.
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Click Finish to complete the installation of the Vault Server. You can now install further components from the selec-
tion mask.
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Installing the HELiOS Client
To install HELiOS, start Windows. If Windows has already been started, close all other applications and start the
installation wizard.

Select a Language for your version.

Click on the HELiOS Desktop button to start the installation.

Before using HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have been installed
on the computer; these packages will be installed as part of the installation if required.
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Please read the Installation Notes and the Licence Agreement carefully.

Select an installation directory. If the installation wizard finds an already installed version, it will be offered to you for
updating.

In accordance with the current Microsoft guidelines, the HELiOS documents will be saved to C:\User-
s\Public\Documents\ISD Software und Systeme\ in case of a new installation. Only the Administrator has write per-
missions for the installation directory (C:\ProgramFiles\..).
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If you work on several workstations without a Vault Server, you need to enter on each workstation the path of the doc-
ument directory into the system file FILEGRUP.DAT. This means that the default path needs to be changed accord-
ingly in all corresponding places of the FILEGRUP.DAT. The directory should be a shared network directory to which
all Clients have access.

Please read these important notes on update installations for Inventor, AutoCAD and SOLIDWORKS carefully and
activate the checkbox . Further information can be found here.
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Please read the Notes on Hardware Exchange carefully.

Hardware Exchange

If you use local HELiOS licenses and want to exchange any hardware components, modify the partitioning of, or
re-install the operating system, you need to revoke the existing license on the HELiOS workstation first, and
request, using the new hardware or modified configuration, a new license key (further information on the pro-
cedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in case
of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new hard-
ware.

Accept the notes to continue with the installation.

You can now start with the installation or modify the Extended Settings for HELiOS.
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In case of a new installation you can specify an arbitrary name for the system data source. In case of an update, the
existing data source will be offered. User and Password will be identical with the ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address input field,
and the Server Port of the Vault Server in the Port input field. You already entered both during the installation of the
Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELiOS Options > Database > General >

Vault Server and specify the connection. For activation you must then restart the HELiOS Desktop.

If you want to process your print jobs via the Plotmanagement of the ISD, you need to install a Print Client on each
workstation. Activate Use Spooler. In the Server field, enter the name of the computer on which you install the
Spooler. The Spooler collects the print jobs and processes them according to your settings.

Individual settings of HELiOS can be distributed to other users or workstations. To do this, create a ZIP file in HELiOS
at View > Settings > Export.

During installation, if the option Use central directory for configuration data (across computers) is activated, you
can save the configurations of the HELiOS Desktop to a central computer and select and import them at Con-
figuration file.
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. You can
only interface 64-Bit versions to HELiOS 64-Bit versions. An exception is the MS Office Interface, where you can link
a 32-Bit Office to a 64-Bit HELiOS. Please note however that an additional, special ODBC connection will be
required for old BOMs. In such cases, please contact the ISD Consulting team.

Multiple selections of HELiOS Interfaces are also possible. The HELiOS functions will be integrated in the programs
that are linked to HELiOS.

Please take a look at the Compatiblity Matrix.to check which interfaces to external software products are supported
by HELiOS.

When installing the CAD interface (AutoCAD, Inventor or SOLIDWORKS) the specific CAD configuration will be con-
sidered. The only thing you need to do is to copy the drawing frame template files from the corresponding ...\tem-
plates\ subdirectory.

The installation automatically executes the configuration file MultiCAD.csv with the HeliosClientConfig.exe tool. If
you work with your own .csv file, you can execute it subsequently: Start the HeliosClientConfig.exe tool from the

\exe\ directory of your HELiOS installation, click the button to select the path of the file and confirm with OK.

Interfaces with foreign systems can also be added via the Windows Control Panel. Select Start > Control Panel > Pro-
grams and Features, activate HELiOS, then right-click and select Change. This starts the installation of HELiOS,
enabling you to select further interfaces with foreign software products on the HELiOS Interfaces tab.

Further information, e.g. how to activate specific interfaces in the foreign software, can be found in the HELiOS
Help.
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Please note:

n A prerequisite for the interface with a foreign software is that his software must be installed on the same sys-
tem.

n An interface between a 32-Bit software and a 64-Bit version of HELiOS is not possible. MS Office is an
exception. Here it is basically possible to interface a 32-Bit Office with HELiOS (64-Bit).

n For EPLAN you also require the Article Synchronization Service running separately on the system. You will
find the corresponding button in the HELiOS installation mask. For the configuration of the HELiOS-EPLAN
interface please contact the ISD Consulting team.

n If you have installed AutoCAD and AutoCAD Mechanical, both will be considered for the interface.

The Activate license administration tools checkbox must be activated for the management of server licenses.

Click Save to save the Extended Settings to an .ini file. If you place the .ini file in the installation directory when
installing server licenses, the settings will be applied.

Close the Extended Settings dialogue with OK.
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Click Install.
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After successful installation, you will find the HELiOS shortcut on the Desktop of your computer for program
start.
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Installing the HELiOS Help
The Online Help is available locally (status of the date of installation DVD creation) and on the Internet (regularly
updated) at www.help.isdgroup.com. Both versions of the Help can be directly launched from HELiOS. Please note
that corresponding login data are required to access the Internet version of the Help.

Start Windows to install the Help. If Windows has already been opened, close all other applications and start the
installation wizard. Leave the selection mask of the installation wizard open, so that you can select the desired com-
ponents one after the other.

Click on the HELiOS Help button.
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Enter the installation directory for HELiOS.
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After successful installation, the Help can be found in the program folder and can be called from HELiOS .
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Installing the HELiOS Internet Servers
For the HELiOS Internet Server you require the Microsoft Internet Information Services . In Windows this is
included, but requires a separate installation/activation that needs to be performed before installing the HELiOS
Internet Server.

To install the HELiOS Internet Server, close all other applications and start the installation wizard.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HELiOS Internet Server button.
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Enter the installation directory for the software. If the installation wizard finds an already installed version, it will be
offered to you for updating.
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Under Server addresses you enter the internet addresses for the HELiOS internet server (e.g. his.isdgroup.com / his-
api.isdgroup.com / hisid.isdgroup.com), including ports and one or more SSL certificates for https matching the
internet addresses.

Enter your Windows user account under API Server user account under which HELiOS functions are to be
executed. Under E-mail connection enter the connection settings of the E-mail server to send "Forgot password" E-
mails as an example. Then click Next.
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Click Install.

After successful installation, the HELiOS Internet Server can be found in the program folder.

Please note:

For server access, passwords for web access must be assigned to the corresponding user logins of the HELiOS
database (see HELiOS Online Help).
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Checking the operability of the individual server components of the HELiOS Internet Server
In a current browser, call up one after the other the domain names specified under Server Addresses including the
Port (e.g. https://his.your-companyname.com:30000).

When calling the server address of the HELiOS Internet Server, you must see the Login page.

When you call up the HELiOS API Server and the HELiOS Identity Server in your browser, you will receive a status
message that the corresponding service is running (e.g. "HELiOS Identity Server is running").

If you do not see a status message, please make sure that the Application Pool of the HELiOS API Server is not run-
ning in the user context.

Therefore, please check the following two settings in the (ISS) Manager Control Panel > System and Security >
Administrative Tools > Internet Information Services (IIS) Manager):

n Check in the Advanced Settings of the Application Pool of the HIS API Pool whether the Load User Profile
option is set to True.
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n Also check if the option loadUserProfile is set to True in the Configuration Editor of the server under the section
"system.applicationHopst/applicationPools".
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Troubleshooting Support
Below you will find solutions to various problems that may occur during the activation of the HELiOS Internet Server.

1. Read and write permission for MachineKeys

How does the problem manifest?
When calling the URL of the HELiOS Identity Server or when logging in to the HELiOS Internet Server, the following
error message appears in the browser: 

Server error in the application /.

The remote certificate is invalid according to the validation procedure.

Description: Unhandled exception while executing the current web request. Check the stack trace to display
more information about this error and to determine where the error was caused in the code.

Exception details: System.Security.Authentication.AuthenticationException: According to the validation pro-
cedure the remote certificate is invalid .

Source error:

An unhandled exception was generated while executing the current web request. Information about the ori-
gin and the location of the exception can be displayed via the stack trace.

Stack trace:

[AuthenticationException: The remote certificate is invalid according to the validation procedure.]

System.Net.TlsStream.EndWrite(IAsyncResult asyncResult) +305

System.Net.ConnectStream.WriteHeadersCallback(IAsyncResult ar) +167

[WebException: The underlying connection has been closed: No position of trust could be established for
the protected SSL/TLS channel..]

System.Net.HttpWebRequest.EndGetResponse(IAsyncResult asyncResult) +762

System.Net.Http.HttpClientHandler.GetResponseCallback(IAsyncResult ar) +81

[HttpRequestException: Error while sending the request.]

…

In the Windows Event Viewer of the server hosting the HELiOS Internet Server, there is a warning to be found in the
"Windows Logs" / "Application" section regarding the ASP.NET source, similar to the following:
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As can be seen in the details, the problem is caused by an access violation of the HELiOS Identity Server in con-
nection with cryptographic keys. The corresponding keywords are highlighted in yellow in the figure below as an
example.
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…

Process information:

Process ID: 5376

Process name: w3wp.exe

Account name: IIS APPPOOL\HeliosIdentity

Exception information:

Exception type: TargetInvocationException

Exception message: Ein Aufrufziel hat einen Ausnahmefehler verursacht.

at System.RuntimeMethodHandle.InvokeMethod(Object target, Object[] arguments, Signature sig, Boolean
constructor)

at System.Reflection.RuntimeMethodInfo.UnsafeInvokeInternal(Object obj, Object[] parameters, Object[] argu-
ments)

at System.Reflection.RuntimeMethodInfo.Invoke(Object obj, BindingFlags invokeAttr, Binder binder, Object[]
parameters, CultureInfo culture)

at Owin.Loader.DefaultLoader.<>c__DisplayClass12.<MakeDelegate>b__b(IAppBuilder builder)

at Owin.Loader.DefaultLoader.<>c__DisplayClass1.<LoadImplementation>b__0(IAppBuilder builder)

at Microsoft.Owin.Host.SystemWeb.OwinAppContext.Initialize(Action`1 startup)

at Microsoft.Owin.Host.SystemWeb.OwinBuilder.Build(Action`1 startup)

at Microsoft.Owin.Host.SystemWeb.OwinHttpModule.InitializeBlueprint()

at System.Threading.LazyInitializer.EnsureInitializedCore[T](T& target, Boolean& initialized, Object& syncLock,
Func`1 valueFactory)

at Microsoft.Owin.Host.SystemWeb.OwinHttpModule.Init(HttpApplication context)

at System.Web.HttpApplication.RegisterEventSubscriptionsWithIIS(IntPtr appContext, HttpContext context,
MethodInfo[] handlers)

at System.Web.HttpApplication.InitSpecial(HttpApplicationState state, MethodInfo[] handlers, IntPtr appCon-
text, HttpContext context)

at System.Web.HttpApplicationFactory.GetSpecialApplicationInstance(IntPtr appContext, HttpContext context)

at System.Web.Hosting.PipelineRuntime.InitializeApplication(IntPtr appContext)

Zugriff verweigert

at System.Security.Cryptography.CryptographicException.ThrowCryptographicException(Int32 hr)

at System.Security.Cryptography.X509Certificates.X509Utils._LoadCertFromFile(String fileName, IntPtr pass-
word, UInt32 dwFlags, Boolean persistKeySet, SafeCertContextHandle& pCertCtx)

at System.Security.Cryptography.X509Certificates.X509Utils.LoadCertFromFile(String fileName, IntPtr pass-
word, UInt32 dwFlags, Boolean persistKeySet, SafeCertContextHandle pCertCtx)

at System.Security.Cryptography.X509Certificates.X509Certificate.LoadCertificateFromFile(String fileName,
Object password, X509KeyStorageFlags keyStorageFlags)

at System.Security.Cryptography.X509Certificates.X509Certificate2..ctor(String fileName, String password)

at Helios.IdentityServer.Startup.LoadCertificates()

at Helios.IdentityServer.Startup.<Configuration>b__1_0(IAppBuilder idserverApp)

at Owin.MapExtensions.Map(IAppBuilder app, PathString pathMatch, Action`1 configuration)

at Owin.MapExtensions.Map(IAppBuilder app, String pathMatch, Action`1 configuration)

…
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How do I solve the problem?
You must give the group IIS_IUSRS write permission for the %ProgramData%\Microsoft\Crypto\RSA\MachineKeys
directory. See also https://github.com/Microsoft/dotnet-framework-early-access/issues/25.

2. "Unexpected error" after login

How does the problem manifest?
After entering the user name and password when logging in to the HELiOS Internet Server, the following error mes-
sage appears in the browser: 

An unexpected error occurred

How do I solve the problem?
Please check whether the ODBC data source for the connection of the HELiOS Internet Server to the database has
been set up as a system DSN connection. If this is not the case, remove the DSN connection in the user context and
replace it with a system DSN connection.

Why this is necessary: The IIS starts the HELiOS Identity Server in a separate process, specified in the user context
during installation. To ensure that the established ODBC connection can be accessed in this user context, it should
be set up as a system DSN connection (user-independent).

3. HIS freezes after login

How does the problem manifest?
After entering the user name and password when logging in to the HELiOS Internet Server, the login freezes, show-
ing a "Please wait" message, even after a longer period of time:

Note: When the HELiOS Internet Server is called for the first time (e.g. after restarting the server), it may take some
time until the login occurs. In the background, the HELiOS core is being initialised and started. Therefore, please
wait for a while and, if necessary, try logging in once more after closing the browser tab and calling the
HELiOS Internet Server URL again.
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How do I solve the problem?
There are two situations that can cause the problem.

User data is wrong or rights are missing

If a "Service Unavailable" page appears when calling the URL for the HELiOS API Server,

please check whether the Application Pool for the HELiOS API Server is running or if it has been terminated. This
can be recognised by the icon or by the status display in the IIS Manager:

If the Application Pool has been terminated (as is the case in the screenshot above), this may be due to data or per-
missions that are stored for the user to run the Application Pool being incorrect.

In this case, you should find a warning regarding the source WAS (Windows Process Activation Service) in the Win-
dows Event Viewer of the server hosting the HELiOS Internet Server, located in the section
"Windows Logs" / "System".

The following text should be included in the details:

…

Application pool HeliosAPI has been disabled. Windows Process Activation Service (WAS) did not create a
worker process to serve the application pool because the application pool identity is invalid.

…

If this is the case, two things must be checked:
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1. User name and password for running the HELiOS API Server must be correct. Please enter the correct data
again if necessary:

2. The user who is stored for the execution of the Application Pool must have sufficient rights (see also https://-
docs.microsoft.com/en-gb/troubleshoot/iis/default-permissions-user-rights#default-windows-user-rights-assign-
ments), specifically the following permissions are required and should be checked:

a. "Sign in as a service"
b. "Sign in as a batch job"

No license available or license already occupied

Check whether there is a hint under C:\Temp\HISLogs\CoreActivities\ pointing to the fact that the license could not
be occupied in the daily log file. If this is the case, please check the available licenses using the ISD Licensing Tool.

4. Background activation service is not running

How does the problem manifest?
All web pages of the HIS (Internet Server, Identity Server, API Server) are not accessible. The corresponding pages
in the IIS Manager are closed and when trying to launch the pages you receive an error message saying that the
background activation service is not running.

How do I solve the problem ?
Locate the "Windows Process Activation Service" (WAS) under Services in the Administrative Tools and start the ser-
vice. If this fails, you can try running the service once by a command line with admin permissions. To do this, type
"net start WAS" into the console window. The start of the service should also fail here but it will display an error mes-
sage.

If "error code 13" is displayed here, please check the IIS log file (c:\windows\iis.log) to see if a line in the form of
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< !!FAIL!! > Failed to create the NetFrameworkConfigurationKey key container (result=0x8009000f)

appears there. If this is the case, it indicates problems with the creation of a cryptographic key in the C:\Users\All
Users\Application Data\Microsoft\Crypto\RSA\MachineKeys folder. If no keys for other relevant applications are
stored there, you can delete the folder as an administrator. Afterwards, you should be able to start the Windows Pro-
cess Activation Service manually again and Windows will automatically recreate the MachineKeys folder.

To prevent data loss, it can be useful to back up the contents of the MachineKeys folder before deleting it.
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Installing the HELiOS Spooler
Start Windows to install the HELiOS Spooler. If Windows has already been opened, close all other applications and
start the installation wizard.

Leave the selection mask of the installation wizard open, so that you can select the desired components one after
the other.

Click on the HELiOS Spooler button.
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Enter the installation directory for the software. If the installation wizard finds an already installed version, it will be
offered to you for updating.
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In the Service registration area you can choose between the options Local system and User account.

A part of the Spooler is started by the system as a background process (Windows service). For safety reasons it is
recommended to create a Windows User account, with User name and Password with read and access permission,
before installation.

If you do not know the user yet, you can choose Local system. The Spooler will then run, initially without access to
any printers, as a simple Windows system service. Now, select Control Panel > Administrative Tools > Services.
Right-click HELiOS Spooler and select Properties. On the Log On tab, switch to This account and enter the User
name and the Password.

Important:

If the Spooler user's password later changes or expires, the password must be reassigned to the HELiOS
Spooler service in the Windows Control Panel at Management > Services via Right-click > Properties > Log
On.

If the Start service upon installation option is active, the Spooler service will not require a manual start after install-
ation.

Normally, the HELiOS Spooler runs as a Windows Service in the background. In this standard configuration the
Spooler process will be started by the operating system in a special session which is not visible for the user. There-
fore, the process will even continue running after the Spooler user has logged off from the computer. Unfortunately,
internal tests have found that problems may occur with this type of operation in conjunction with some CAD sys-
tems; currently this applies in particular to the interface with SOLIDWORKS.

If you are considering using the HELiOS Spooler together with SOLIDWORKS, we therefore recommend choosing
the Start in interactive mode option during installation in order to avoid problems. When this option has been selec-
ted, the Spooler will no longer be set up as a service, but will be started directly in the foreground via the Admin-
istration UI. During this type of operation, the Spooler process will appear in the form of a small text window in the
window bar (Caution: When you log off from the Server, the Spooler process will also be ended here!)
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For starting the “interactive” configuration of the Spooler automatically, the file Helios.Spooler.exe from the install-
ation directory must be invoked with the option “—no service”, for instance, either from the “Autostart” folder or via
Windows task planning. If you have further questions, please contact our ISD Consulting team.

Select the data directory. Activate the Create network share checkbox to enable the communication with the PrintCli-
ent. If the network share is not created during installation, it must be created manually afterwards. Since special set-
tings will be required here, we recommend contacting our Consulting team.

Choose the CAD system that you want to link to the HELiOS Spooler, and click Next.

In this dialoguie window you will be asked for the login of the database user, which is the login of the (SQL) database
system.

Under System data source you must then select the corresponding ODBC database connection. The HELiOS User
via which the Spooler will run is also selected here. It is important that this user has administration rights and is also
assigned to the HELiOS Group "PDM Administrators" at this point. Otherwise you will receive an error message.

Activate Use Vault Server and enter the Address and Port of the Vault Server installed in the system for your Multi-
CAD operation.

Click Next.
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Click Install.

Click Finish to complete your installation.

After successful installation, the HELiOS Spooler can be found in the program folder.
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Installing the EPLAN Article Synchronization
In addition to the EPLAN interface that must be activated in the HELiOS Interfaces tab of the Extended settings win-
dow, you need to install the EPLAN Article Synchronization service. You can find the corresponding button at the
bottom right of the selection mask.

Please note:

For the configuration of the HELiOS-EPLAN interface please contact the ISD Consulting team.

To install the HELiOS Spooler, please start Windows. If Windows has already been started, please close all other
applications. Insert the DVD in your DVD drive. The installation wizard will then be started automatically.

Click on the EPLAN Article Synchronization button.
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Enter the installation directory for the software.
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In the User field, enter the User login for HELiOS, (or a user account) with access to HELiOS.

You can now begin with the installation or modify the Extended settings, e.g. for HELiOS.
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The existing system data source will be suggested. User and Password are identical to those for the ODBC login. If
you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address input field,

and the Server Port of the Vault Server in the Port input field. These can be found at > HELiOS Options >
Database > General > Vault Server .

Click Save to store the Extended settings in an .ini file. Confirm withOK.
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Click Install to start the installation.

After successful installation, the EPLAN menu will contain the Synchronize articles with HELiOS function in the
PDM menu.
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Configuration
Company- or user-specific requirements can be conveniently adapted to the configration.

n Configuration HELiOS (Central Distribution of Settings)

n Parameter Configuration for HELiOS
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Configuration HELiOS (Central Distribution of Settings)
During installation of HELiOS you may either import the HELiOS settings (e.g. user interface, masks and attribute
assignments) as a ZIP package as usual or provide them locally (in a network folder). HELiOS then checks for newer
settings when the application is started and updates the local settings accordingly.

During the optional query for UI configuration, it is possible to distinguish between a local and a central (cross-com-
puter) directory. This allows you to save the HELiOS configuration for several workstations in a central directory
instead of having to "distribute" it to the individual local directories. To do this, create a ZIP file in HELiOS under
HELiOS Options > MANAGE... > Export settings.

If you select the option Use central directory for configuration data in the new or update installation, a directory

(e.g. network drive) must be selected via Windows Explorer instead of the local Configuration filein .ZIP format.
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Change Installation

A Change Installation from HELiOS offers the option to change a central configuration subsequently. However, a
subsequent selection of a local Configuration file is not required here. If would like to change the configuration file
subsequently, use the HELiOSConfigImport.exe tool.

Please note:

n Settings files that are provided by the administrator in a central directory must be selectively copied to that
directory. The directory structure provided by HELiOS must be observed due to the dependency on files.
This must correspond to the directory structure defined in %APPDATA%\ISD Software und
Systeme\HELiOS 2022. If in doubt, contact the ISD consulting team if you have any further questions.

n If the set configuration directory is not accessible at runtime, HELiOS behaves as if it is empty. This means
that the program starts without updating the interface configuration.

n During the update installation of HELiOS for an older HiCAD version (before 2020), the option for setting the
configuration directory is missing and can only be adjusted via the registry. If you have any questions,
please contact the ISD consulting team.

n When updating an older HELiOS to HELiOS 2020 or higher, old mask files (in the \sys\ directory of the
installation) are converted to the new XML format during the process and saved under %Program Data%.
This conversion is not dependent on whether the local or central directory was selected for the interface
configuration. The old configuration file can then be found in a backup directory created by the operation
below the installation folder.
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n The new masks at %Programdata% should not be overwritten in any case, because these are the "delivery
status", which may be updated by later update installations. If masks are edited and changed with the mask
editor, they are stored at %Appdata% and are called up by HELiOS when working in corresponding masks
from this directory. This means: If masks are to be distributed uniformly to different workstations, they must
be saved under %Appdata% and not (!) under %Programdata%

72 / 146 Installation Notes

Configuration



Parameter Configuration for HELiOS
HELiOS provides appropriately adjusted user interfaces and configurations for various interfaces. During installation
of HELiOS the MultiCAD.csv file, that sets up the templates required for the operation of the interface, will auto-
matically be run via the HeliosClientConfig.exe program.

You can also load an own *.csv file subsequently if desired. In the EXE directory of your HELiOS installation, start the

HeliosClientConfig.exe program. Click the button to select the path of the CSV file and confirm with OK.

Furthermore, HELiOS offers template files for title blocks (AutoCAD drawing frames with database attributes) and
HELiOS masks that have been adjusted for Multi-CAD operation:

n In the …\templates directory of your HELiOS Desktop installation you will find the adjusted HELiOS masks for
Multi-CAD operation in the …\MultiCAD folder. Copy them to the …\sys directory of your HELiOS installation.

n In the…\templates\AutoCAD\ directory you will find drawing frame templates that you can copy to the cor-
responding templates directory of your CAD software
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Update
n Licensing in Case of Updates

l Updating the Server License
l Updating Local Licenses

n Carrying Out the Installation

n Data Compatibility of HiCAD/HELiOS

n Update of HELiOS

l Backups Before Performing the HELiOS Update-Installation
l Update Installation of HELiOS

n ISD Update Service

l Installing the ISD Update Service
l Using the ISD Update Service
l ISD Update Service: Settings

n Updating the HELiOS Database (Database Schema)

n Mask Converter for HELiOS

n Manual Registration of Multi-CAD Add-ins

Important notes on updates!

Hardware Exchange

If you use local HELiOS licenses and want to exchange any hardware components, modify the partitioning of, or
re-install the operating system, you need to revoke the existing license on the HELiOS workstation first, and
request, using the new hardware or modified configuration, a new license key (further information on the pro-
cedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in an
appropriate amount for the reissuing of the license. If the license will not be revoked, or if such revocation is no
longer technically possible, the ISD may request proof that the unrevoked license is no longer utilisable; in case
of failure to produce such proof, the ISD reserves the right to refuse the transfer of the license to a new hard-
ware.

Licenses

Before updating HELiOS, you must deactivate all licenses (Server Licenses or Local Licenses). The procedures
for Server Licenses and Local Licenses are different.

74 / 146 Installation Notes

Update



Data compatibility

When performing a HELiOS update, the update start mask shows you the HELiOS subversion, which needs to
match the existing database. If this is not the case, only an error message will appear when you start HELiOS.
To update the database schema, use the program HeliosDbUpdate.exe. If the database schema requires an
update, you can no longer access the database with older HELiOS versions. Therefore, all workstations access-
ing the database need to be readjusted accordingly at the same time.

Administrator

Before carrying out an update you should inform the responsible Administrator to ensure a well coordinated
switch to the higher version.

Update HELiOS

In the context of HELiOS Update Installations, the last 5 release cycles are supported. As of HELiOS 2022 (Ver-
sion 270*.*), you can only update installations from 2017 (Version >= 2200.0) and newer. (See also Carrying
out the installation.)

Backup HELiOS

It is mandatory to make a database backup before carrying out an update, as the update can normally only be
reverted by importing the backup.

HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You should make sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path %appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.
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New Mask Editor in HELiOS 2020

Due to the complete revision of the Mask Editor in HELiOS 2020, the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in some
changes in the system architecture that Administrators must consider:

n The masks of older versions (before V 2500.0) that were previously stored in the SYS directory of the install-
ation are automatically converted to the new XML format in case of an update installation and stored at
%Programdata%.

n The new masks at %Programdata% should not be overwritten under any circumstances, as these rep-
resent the "delivery status", which will be updated by later update installations. If masks are edited and
changed with the Mask Editor, you must store and call them at %Appdata%.

Updating the HELiOS-Inventor interface

For an update of the Inventor interface from an older HELiOS version to HELiOS 2020 (Version 2500) or higher
(and the corresponding update of the database schema) the following changes have to be considered:

1. The structure identifiers for Inventor parts must be updated.

2. The standard part and semi-finished product identifiers are changed to a document-based (instead of art-
icle-based) management.

An update installation can only be carried out after an appropriate preparation of the migration.

In case of an update, please contact the Consulting team of the ISD Group. New installations of HELiOS 2020
and the associated database are not affected.

Updating the HELiOS-SOLIDWORKS interface

For an update of the SOLIDWORKS interface from an older HELiOS version to HELiOS 2020 (Version 2500) or
higher (and the corresponding update of the database schema) the following changes have to be considered:

Since a migration of the configuration IDs is performed during the update, an update installation can only be
performed after the migration has been prepared accordingly. In the event of an update, contact the Consulting
team of the ISD Group. New installations of HELiOS 2020 and the associated database are not affected.
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Important update notes for attribute mapping in title blocks

Until HELiOS 2019, attribute mapping at SOLIDWORKS was done by the following files:

n heliossw_titleblock.dat (attributes for the title block),

n helios_cs_global_config.dat (attribute mapping/presetting in both directions),

n sw_comp_name.dat (display in the model tree in CAD).

As of HELiOS 2020 (Version 2500.0), the mapping must be set up again manually. No migration tools exist.

Up to HELiOS 2019, the attribute for the title block in AutoCAD was created using the following files:

n heliossac_titleblock.dat,

n helacblock.xml

As of HELiOS 2020 (version 2500.0), the mapping must also be set up manually here.

In case of an update, please contact the Consulting team of the ISD Group.

HELiOS List attributes

The database subversion update (HELiOSDbUpdate.exe) checks from HELiOS 2022 onwards whether list
attributes with other data types than VARCHAR exist. If this is the case, the database subversion update for
updating the database schema will not be carried out. In this case, please contact the ISD in order to migrate
with the help of the Consulting the corresponding attributes to data types that will be supported in the future.

Important notes for administrators during a HELiOS update installation working with the HELiOS integ-
ration for Inventor, AutoCAD and SOLIDWORKS!

When updating the database to HELiOS 2019 Service Pack 2 or higher, the old workspace is checked for doc-
uments in progress. These are documents with the pen symbol in the respective (old) workspace dialog, or
entries of locked documents in the Workspace Manager from HELiOS Desktop (on the right hand side).

Should the check find relevant documents, the following message appears:

The update of the database cannot be performed because there are still locked documents in old local work
areas which will not be supported in the future. After this update, only work areas with new administration are
supported and automatic migration is not possible. More information can be found here.

Material Manager

The Material Manager (materialmanager.exe) that enables a taking over of materials from Catalogue Editor to
HELiOS needs to have the same database schema as HELiOS. Therefore the Material Manager will also be
updated.
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Licensing in Case of Updates
Before updating HELiOS, you must deactivate all licenses (Server Licenses or Local Licenses). The procedures for
Server Licenses and Local Licenses are different.

Updating the Server License
For a Server license the License Server software and the License Management tools may require an update. Fur-
thermore, you need to deactivate the licenses for the old Version first, and then activate those for Version 2022.

You can start with the installation of HELiOS before or after activation of the new licenses; a starting of the software
is, however, only possible after activation of the new licenses.

The current Version of the License Server, Sentinel RMS License Manager 8.6.2, can be found on the installation
medium of HELiOS 2022. If you have an older version, you need to uninstall this version with the help of the Win-
dows Control Panel. First, uninstall the Sentinel RMS License Manager there and (if there are any) the
AdminToolsServer.

You can then install the new version of the License Server from the installation medium. Start the installation wizard .
In the selection mask of the installation wizard, click on the License Server button.

Before you can use the new licenses of HELiOS 2022, you need to deactivate the old licenses with the help of the
License Manager. This tool is located in the Windows Start menu at All programs > ISD Software und Systeme >
Administration.

After starting the ISD License Manager the License Activator tab will be active. Normally, the EID (Entitlement ID)
field is still filled in and the fields E-mail and Password are still empty. The activated modules of the old Version are
highlighted (blue). Click on the Deactivate button to revoke the activation of these modules.

To activate the new licenses you require the ISD License Manager. After installing HELiOS 2022 this tool will be avail-
able to you in the Start menu of Windows at ISD Software und Systeme > Administration.
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Another prerequisite for the activation of the new licenses is their requesting via the new Update form (isdgroup.com
> Support & Schulung > ISD Wiki > Download) and the subsequent provision of the licenses by the ISD. .

Start the ISD License Manager, which you can find in the Start menu of Windows at ISD Software und Systeme >
Administration(C:\Program Files (x86)\ISD Software und Systeme\AdminToolsServer\exe).

On the License Activator tab, enter the Entitlement ID, your E-mail address and your Password and click Login.
After connecting to the ISD License Server, all your purchased licenses will be shown. Use the checkboxes to select
the modules that you wish to activate and confirm your selection with a click on the Activate button.

After successful activation you can start HELiOS.

Updating Local Licenses
Before installing HELiOS 2022, you need to deactivate the local licenses of the old version on your workstation. After
installing HELiOS 2022, you need to activate the new licenses.

To deactivate the old licenses you use the ISD License Manager, which is located in the Windows start menu at ISD
Software und Systeme > Administration (C:\Program Files (x86)\ISD Soft- ware und Systeme\Ad-
minToolsServer\exe).

On the License Activator tab, click on the Deactivate button to revoke the activation of the modules, i.e. to deac-
tivate them. After successful deactivation, a corresponding message will be displayed.

To activate the new licenses you require the ISD License Manager 4.0. After installing HELiOS 2022 this tool will be
available to you in the Start menu of Windows at ISD Software und Systeme > Administration.

Another prerequisite for the activation of the new licenses is their requesting via the new Update form (isdgroup.com
> Support & Schulung > ISD Wiki > Download) and the subsequent provision of the licenses by the ISD. After
installing HELiOS, start the ISD License Manager, which you can find in the Start menu of Windows at ISD Software
und Systeme > Administration(C:\Program Files (x86)\ISD Software und Systeme\AdminToolsServer\exe).

On the License Activator tab, enter the Entitlement ID, your E-mail address (the address to which the E-mails of the
Activation@isdgroup.de were sent) and your Password and click Login.

After connecting to the ISD License Server, all your purchased licenses will be shown. Use the checkboxes to select
the modules that you wish to activate and confirm your selection with a click on the Activate button. The selected
modules will then be activated on your workstation. You can deactivate them again at any time to enable their use on
a different workstation.

After successful activation you can start HELiOS.
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Carrying Out the Installation
The installation of HELiOS can be carried out by the Consulting of the ISD. In the context of Update Installation, the
last 5 release cycles are supported.

We recommend to note the following instructions:

1. Users with sufficient background knowledge can generally perform the updates themselves.

2. When performing an Update Installation, the "Installation Notes" must be read/considered thoroughly. The
responsibility lies with the user. Updates generally fall under the category "Consulting". Therefore, questions
about the Update Installation that go beyond purely functional questions about the installation are subject to a
charge.

3. When performing an Update Installation, in addition to reading the "Installation Notes", we always recommend
carrying out a test update as part of a test installation first and, only if this is successful, carrying out the update
in the live system. Customer-specific adjustments to the HELiOS installation may have to be updated/adjusted
as part of the test installation.

Since the effort of an update increases with the number of skipped versions, we generally recommend an install-
ation by the ISD. This also saves the user from having to familiarize themself with the Update Installation topics and
ensures that nothing will be forgotten.
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Update of HELiOS
The ISD recommends performing an Update Installation when switching from an old version to HELiOS 2022 or for
the installing of Service Packs and Patches. Before the update, create a backup of the HELiOS Database.

Backups Before Performing the HELiOS Update Installation
Before starting the Update Installation of HELiOS, you should create a backup of the database (see also Install-
ationGuide Microsoft SQL Server). To do this, start the HELiOS Database Creator.

After entering the user data - user sa, the password and the SQL Server to be connected to - select Login.
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Then enter the name of your database and the export path. The export path must not contain any files. Click on the
Export button.
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After exporting successfully, a message is displayed which you confirm with OK.

The log file of the procedure can be found at %Appdata%\Roaming\ISD Software und Systeme\HELiOS\%Daten-
bankname%\_Helios_Export.log and the configuration can be found at %Appdata%\Roaming \ISD Software und
Systeme\Helios.DBImportExport\DBImportExportConfig.

Update Installation of HELiOS
You can conveniently download the current HiCAD version in the Download Area in the ISD Wiki. Please note that a
HELiOS update usually requires you to also update the database.

Close all other applications and start the installation wizard. For the installation, it is essential to start the setup.exe
file from the root directory of the ISO file; this is the only way to ensure that the installation wizard recognises the
operating system correctly and installs the appropriate HELiOS version.

Then select the language of the version.
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Click on the HELiOS Desktop button.

Before using HELiOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must be installed on the
computer; if required, these packages will now be installed.

Please read the Installation Notes and the Licence Agreement carefully.
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If the installation program finds an already installed HELiOS Version, this will be indicated in a corresponding dia-
logue window.

Activate the Update-Installation option and click Next.

You can now start with the installation or modify the Extended Settings for HELiOS.
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In case of a new installation of HELiOS you can specify an arbitrary name for the system data source. In case of an
update, the existing data source will be offered. User and Password will be identical with the ODBC login.

If you are using a Vault Server, Use Vault Server is activated and the Address and Port are entered. The data of the
Spooler is also taken over.

Individual settings in HELiOS can be distributed to other users or workstations (see Configuration HELiOS (Central
Distribution of Settings)). To do this, create a ZIP file in HELiOS under HELiOS Options > MANAGE... > Export set-
tings. If you then select the option Use central directory for configuration data during the installation, you can select

the ZIP file via the Windows Explorer in the selection dialogue after clicking the button.
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. With the
exception of the Office Interface, you can only interface 64-Bit versions to HELiOS 64-Bit versions. Multiple selection
of HELiOS Interfaces is also possible. The HELiOS functions are integrated into the programs that are linked to
HELiOS.

Please refer to the Compatibility Matrix to find out which interfaces to external software are supported by HELiOS.

You can also add interfaces later via the Windows Control Panel. To do this, select Programs and Featuresin the
Control Panel, activate HELiOS and then right-click to select Change. The installation of HELiOS is started and you
can select further software on the HELiOS Interfaces tab.

Furthermore, the tool HeliosCouplings.exe (in the /exe/ directory of the HELiOS installation) is available for estab-
lishing interfaces.

Please note:

n A prerequisite for establishing interfaces with Multi-CAD software is that the corresponding software is also
installed on the corresponding system.

n Establishing an interface between a 32-Bit software and a 64-Bit version of HELiOS is not possible. An
exception is MS Office. Here it is generally possible to interface a 32-Bit Office to HELiOS (64-Bit).
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n For EPLAN you also require the Article Synchronization Service running separately on the system. You will
find the corresponding button in the HELiOS installation mask. For the configuration of the HELiOS-EPLAN
interface please contact the ISD Consulting team.

n If you have installed AutoCAD and AutoCAD Mechanical, both will be considered for the interface.

If you checkmark the Activate ISD Update Service option, a Hotfix will be searched on the ISD Web Server when you
start HELiOS. You can also activate this option subsequently via the Windows Control Panel: There, selectPrograms
and Features, right-click on HELiOSand selectChange.

Close the Extended settings dialogue with OK.
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Click on the Install button.
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After successful installation, you will find the HELiOS shortcut for starting the program on the Desktop of your
computer.

Improvements of the HELiOS functionality require an update of the database. If the database is no longer up-to-
date, this will be indicated by a message when HELiOS is started. Use the program HeliosDbUpdate.exe to update
the database schema.
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ISD Update Service
The automatic search for and installation of HELiOSupdates (Hotfixes). For this you require the program ISDUp-
dateSvc.exe, that you can either activate during installation of HiCAD or install via the Windows Control Panel after-
wards.

Installing the ISD Update Service
You can activate the automatic search for and installation of HELiOS updates (Hotfixes), either during the installation
of HELiOS or, later, via the Windows Control Panel.

During installation you can go to Extended settings > General and activate the Activate ISD Update Service option
to activate the automatic search for Updates on the ISD Server. You can also activate or deactivate this option after-
wards via the Windows Control Panel.
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In the Windows Control Panel, choose Programs and Features, right-click on HELiOS and choose Change.
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Checkmark Activate the ISD Update Service and click Next. After all options have been queried, click Change.

After successful installation, the program ISDUpdateSvc.exe will be located by default in directory C:\Program
Files\ISD Software und Systeme\ISD Update Service

Using the ISD Update Service
If you have installed the ISD Update Service, the following message appears at the bottom right of your screen
whenever a Hotfix is available:

Click on the message or double-click on the icon at the bottom right to start the ISDUpdateSvc.exe program. You
can also directly double click on the ISDUpdateSvc.exe file to start the program. Confirm the query in the Windows
User Account Control dialogue window.
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If an update is available, click the Download button to download it from the ISD Server to your computer. If an
update should not be displayed anymore, activate the Hide... checkbox.
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After downloading of the Hotfix, click Install.

Confirm the Windows Security Warning with Install.

Follow the instructions on the screen to install the update.

The HELiOS Info window indicates the current HELiOS version number (incl. build number) and the numbers of

installed hotfixes. To display the Info window, click Help Topics and Information on the top of HELiOS Desktop
and then select HELiOS Desktop.
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ISD Update Service: Settings

If you have installed the ISD Update Service, you can, after calling the program (with the icon at the bottom right
on the Windows Taskbar, or by double-clicking on the file ISDUpdateSvc.exe), configure the search and the install-
ation with the Settings button.
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Via the Settings button you can specify the download directory for Updates and a time interval for the search for
updates.

You can use the icon to start the search for updates manually.
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Updating the HELiOS Database (Database Schema)
Improvements of the HELiOS functionality require a regular updating of the database; if the database version is no
longer up to date, HELiOS displays the following message (version numbers may vary) when it is started:

To update the database schema, use the program HeliosDbUpdate.exe.

HELiOS Data base schema

As existing datasets with non-compliant conditions may cause conflicts during the central update process of
the HELiOS delivery database, you should consider the following:

1. Do a database backup: You should make sure that a backup of your HELiOS database has been created
before the update. This can be done with the HELiOS Database Creator or via your SQL server application.
Please contact the ISD hotline if you have any questions or need support for your individual system archi-
tecture.

2. The log file of the update: If any conflicts occur during the update, they are traced in the log file
HeliosDbUpdate.txt (in the system path %appdata%\ISD Software and Systems\HeliosDbUpdate\). Have
this file ready if you contact the ISD hotline for troubleshooting and successful updates.

Please note:

n It is mandatory to make a database backup before the update, as the update can normally only be reverted
by importing the backup.

n After an update, access is only possible with the appropriate HELiOS version. A mixed operation with
HELiOS versions requiring an older database schema is not possible.

n The update must be performed once and applies to all HELiOS installations.

n As of HELiOS 2022 SP 1 (Version 2701), HeliosDbUpdate.exe no longer supports databases older than
sub-version 212 (corresponds to the database delivered with HELiOS 2013, Version 1800). In this case,
use an older version of HeliosDbUpdate.exe or contact the Consulting department of the ISD.
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n The responsible administrator should always be informed prior to the update, in order to enable a coordin-
ated conversion.

n In some cases, a window with the message "The designations of the database attributes must be updated."
will be displayed during the update process. In such cases, the language-dependent standard designations
for attributes will be updated. This applies only to standard designations of attributes which have not been
changed or created by the user, i.e. only for attributes according to the default settings. This means that
designations that were assigned via Attribute Editor by the user will remain unchanged in the process.

n When updating a HELiOS version older than HELiOS 2022 Service Pack 2 (version 2702) to a newer one,
an extended range of functions for deriving projects and folders is implemented. Please note that folders
created via action lists of the workflow management or containing subfolders created via action lists cannot
be derived. If corresponding folders are found in your database when updating the database schema, you
will receive the following message:

n "The functions for deriving project and folder structures have been extended. Currently it is not possible to
derive folders which were created via action lists or which contain folders created via action lists with these
functions. Since such folders exist in your database, please contact the ISD Consulting department to see to
what extent adjustments will be necessary in the future."

The update can be performed from any HELiOS workstation with a database connection. The HeliosDbUpdate.exe
program is used for this purpose. It can be started via the Windows Explorer, or similar programs, from the exe dir-
ectory of the HELiOS installation.

The following mask (software and database version may vary) will be displayed after starting the program:

Click the Update database… button to start the update.

The following message (version numbers may vary) will be displayed after clicking the button.
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If you confirm this message with OK, another confirmation prompt is displayed.

Confirm with Yes to perform the update. After a successful update, the following message will be displayed.

A further check can be carried out by clicking the Re-determine button in the main window of the program, after
confirming this message with OK.

After a successful update, software version and database version should be identical.

Please note:

If you use HiCAD and HELiOS together it may occur after an update of HiCAD that according to the error mes-
sage for verification of your database version the number of the required sub-version is lower than that of the
current one, which is, according to the message, not supported.

In this case, please contact our Hotline:

Tel: 02 31 / 97 93 - 166

Fax: 02 31 / 97 93 - 101

E-Mail: support@isdgroup.com
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Manual Registration of Multi-CAD Add-ins
If you use both HiCAD and HELiOS on your system in mixed operation it is not possible (as opposed to the stan-
dalone version of the HELiOS Desktop) to establish an interface between HELiOS and further CAD or CAE software
via an update or modification installation.

To do so you can use the HeliosCouplings.exe tool (in the /exe/ directory of the HiCAD installation).

It can be used to activate interfaces with AutoCAD, Inventor, SOLIDWORKS or EPLAN.

Activate the checkbox of the required software and confirm with OK. The interface will then be activated.

The respective software has to be installed in the system.
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New Mask Editor for HELiOS
The Mask Editor (as of HELiOS 2020) has been completely revised. Besides a modern ribbon design, which also
supports operation at high resolutions, the basis for a further expansion of the masks and the editor has been laid.

The revision of the mask editor has also led to a conversion of the mask format to XML. Mask files are now managed
outside the installation directory.

New mask format and central mask configuration
In HELiOS 2020, the previous mask format has been changed from .msk to .xml, parallel to the revision of the mask
editor. In addition, mask files are now managed outside the installation directory, resulting in some changes in the
system architecture that administrators should urgently consider:

The masks of older versions that were previously stored in the \sys\ directory of the installation are automatically con-
verted to the new XML format by an update installation of an older HELiOS version to HELiOS 2020 (V 2500.0) or
higher and stored at%Programdata%.

At %Programdata%, the masks are stored in a version-specific path, i.e. for HELiOS 2020 this path could look like
this: "C:\ProgramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks". In a later version, the version identifier
in the path will be correspondingly higher.

This conversion or directory is not dependent on whether the local or central directory was selected for the interface
configuration (see below).

The old configuration file can then be found in a Backup directory that was created below the installation folder.
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The new masks at %Programdata% should not be overwritten in any case, because these are the "delivery status",
which may be updated by later update installations. If masks are edited and changed with the mask editor, they are
stored at %Appdata% and are called up by HELiOS when working in corresponding masks from this directory.

Important:

This means: If masks are to be distributed uniformly to different workstations, they must be saved under %Ap-
pdata% and not (!) under %Programdata%.

Mask Converter
During the update installation - starting from an installation earlier than HELiOS 2020 - the tool MskToXm-
lUpdate.exe is placed in the exe directory of the HELiOS installation. This tool is used by the installation program
when updating to HELiOS 2020 for automatically converting masks in the old MSK mask format to the new XML
mask format. The images contained in the masks are also copied together with the masks.

If necessary, this tool can also be used to convert old mask files to the new XML mask format at a later date. To do
this, the tool must be started as administrator from the Windows command line as follows

MskToXmlUpdate –BACKUPPATH=path name –MSKPATH=path name

A path must be specified for both the BACKUPPATH and MSKPATHparameters.

BACKUPPATH

Here the directory must be specified to which the "old" MSK/BMP files are to be moved after conversion.

After the conversion, a conversion log with the name _MskToXmlResult.txt is saved in this directory.

MSKPATH

Here the directory has to be entered containing the files to be converted.

Example:

MskToXmlUpdate –BACKUPPATH=C:\helios\sys\backup_msk -MSKPATH=C:\helios\sys\

The files are automatically converted into the file %PROGRAMDATA% of HELiOS, for instance […]\Pro-
gramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks.
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n Server Monitor

n Theft of a Workstation
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General Notes on Licensing
HELiOS can be activated via 3 types of licenses:

n Standalone Licenses (Local Licenses)

n Network Licenses

n Commuter Licenses

Please note:

n A static IP address is required for a correct operation of the License Server.

n If you activated a license while the WLAN card is switched on, this license will only be valid and visible when
the WLAN card is switched on.

n In the HELiOS directory DOCU you can find an Online Help for the Licence Manager. You start the Help by
calling the LICENSEMANAGER.HTML file in the folder Docu\tools\Licensemanager.

n In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF document Use case: Checkout
Licenses.

General Information on Local (Workstation-specific) Licenses
If you choose local licensing, the activation will be directly locked to the hardware of the workstation on which your
HiCAD and HELiOS Desktop program is installed.

The ISD will send you an E-mail containing the Entitlement ID for local licenses (standalone). This ID will be required
for the activation and deactivation of the licenses and software modules. Please keep the Entitlement ID! Without
this ID you cannot activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will be pos-
sible without the Entitlement ID! After installing HELiOS , you activate the licenses by means of the License Activator
in the ISD License Manager.

General Information on (Server-controlled) Network Licenses
If you choose network (server-controlled) licensing, the license will be directly locked to the hardware of the server
that centrally manages the HELiOS licenses. These licenses can be used on any workstation in your network that is
connected to this server.

The ISD will send you an E-mail containing the Entitlement ID. If you have several network servers, e.g. at several loc-
ations, you will receive one Entitlement ID for each network server. This ID will be required for the activation and
deactivation of the licenses and software modules. Please keep the Entitlement ID! Without this ID you cannot activ-
ate or deactivate any licenses! In case of a defect, no reconstruction of licenses will be possible without the Enti-
tlement ID! You activate/deactivate the network licenses by means of the License Activator in the ISD License
Manager.

To be able to use network licenses, a License Server needs to be installed on a computer without HELiOS.

The license server enforces and manages licensing in multi-user environment. It keeps track of all the licenses and
handles requests from network users who want to run a HiCAD/HELiOS application, granting authorization to the
requesters, or denying requests if all licenses are in use.

The license server must not be installed on the same computer on which an ISD software product (HELiOS) is
installed, as both product share system data concerning the licensing information. Formerly, such parallel install-
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ations of license servers and ISD products were performed in cases where a customer occasionally wanted to trans-
fer the license to another computer (Remote Commuter License).

Important:

Installations of license servers and ISD products on the same computer are no longer covered by the warranty.
The ISD group advises you strongly not to perform such installations.

A static IP address is required for correct operation of the license server.

General Information on Commuter Licenses
Individual licenses can be checked out from the server and locked to a workstation within or outside the network
(so-called “commuter licenses”). This enables you to continue working at a different location, without being con-
nected to the license server (unless your HELiOS installation requires a connection to a database server). For this
purpose you define a specific period during which you want the license to be available on a selected workstation. For
this period, this license will be blocked on the license server. After expiry of this period, the license will be made avail-
able on the license server again. It is also possible to manually return this license to the server before expiry of the
defined period, if the workstation is connected to the server. Licenses for one workstation can be checked out for at
least one day, with the counting beginning at 1:00 AM on the day following the checkout date.

If you want to replace/exchange your license server, you need to deactivate all licenses first.

Practical Examples of Network Licensing
n Let us assume that three licenses have been activated on your server. Monday morning (11.00 am) you sud-

denly need to see a customer for design tasks, and you know that you will still be on-site at the customer’s facility
on Tuesday. You therefore check out a license for 24 hours on 11.00 am. This means that you can use this
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration of this period, the license is
automatically made available again on the server. If you manage to finish your work on Tuesday at midday, you
can go back to your office and return the license to the server somewhat earlier.

n Similar situation as the one described above, with the difference that you are not in your office on Monday,
11.00 am. In such cases you can generate a hardware ID, enabling your colleagues in the office to check out a
license for you. This license is sent to you by E-mail and can then be activated. In contrast to the previous
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example, this license is exclusively available to you for a fixed period of time and cannot be returned to the
server before expiration of this period.
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Installing the License Server
If you want tp perform a HELiOS update to Version 2022 and use a license server (i.e. work with network licenses),
you require Version 8.6.2 of the License Server. If you have installed an older version, you need to uninstall it before
re-installing the License Server.

To install the License Server, start Windows. If Windows has already been opened, close all other applications and
start the installation wizard.

Leave the selection mask open, open, so that you can select the desired components one after the other.

Click on the License Server button.
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After successful installation you will find the Server (Sentinel RMS License Manager) under Services. From here you
can also start and end the License Server.

Important:

To ensure that the HELiOS Client will find the correct License Server, an environment variable LSFORCEHOST
should be set on each Client using network licenses. The value HOSTNAME, respectively the IP address of the
License Server is assigned to the variable.
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Licensing via Entitlement ID (License Activator)
The ISD License Manager significantly facilitates the communication between the customer and the ISD during
licensing.

Important:

For the activation of HELiOS 2022 the ISD License Manager 4.0 will be required.

AutoRequest Licenses
When acquiring a HELiOS license, you will obtain one Entitlement ID for local licenses (Standalone) and another one
for network licenses (Network). If you have several network servers, e.g. at different locations, you will obtain one
Entitlement ID for each network server. These numbers will be required for the activation and deactivation of the
licenses and the software modules.

Important:

Please keep the Entitlement ID! Without this number you cannot activate or deactivate licenses. In case of a sys-
tem crash a reconstruction of the licenses cannot take place without the Entitlement ID.

After installing HELiOS you can find the program in the Windows Start menu at ISD Software und Systeme > Admin-
istration. Please note that for the execution of some functions, administrator rights are required.
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The range of functions of the ISD License Manager depends on the activation of the License Administration Tools
option. The information about this setting is entered in the Registry and can also be changed there subsequently if
desired (please contact the Hotline).

Important:

To activate/deactivate Network Licenses, always start the ISD License Manager via the Windows Start menu:
Select Start > All programs > ISD Software und Systeme GmbH > Administration. To avoid errors when activ-
ating/deactivating licenses, perform an update of the new ISD License Manager and/or the License Admin-
istration Tools beforehand.

Activate the License Activator tab and enter the Entitlement ID, your E-mail address and your Password. New cus-
tomers obtain their password from the ISD Hotline. With this password you can also access the Download Area.

After entering the data, click Login. The ISD License Manager connects to the ISD License Server and the acquired
licenses will be displayed.

This process may take several minutes. You can then activate the licenses.
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Activate Licenses
After successful Login the number of available licenses and the number of acquired licenses are indicated next to
each module.

Select the modules to be activated and click Activate to start the activation. For Server Licenses the modules are
already pre-selected.

After successful activation a message showing you that all licenses have been successfully activated will be dis-
played:

You can then log out and work with the HELiOS modules.

In addition, you will receive an E-mail informing you about the deactivated modules.

For Network Licenses, all modules will always be activated or deactivated (for further information about the oper-
ation of the License Manager, please read the Online Help for the License Manager).
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Deactivate Licenses
A deactivation of licenses for modules will be required in the following situations:

n Exchange of hardware or changing of hard disk partitioning

n Update of the operating system (e.g. from Windows 8 to Windows 10

n For updates within one version no deactivation will be required

n Transfer of local modules from one workstation to another

n Acquisition of further modules, or return of hired licenses

n Switch from local licenses to network licenses

Please note the following: All workstations with modules having the same Entitlement ID need to be deactivated com-
pletely before a redistribution of the module licenses can take place.

Close all HELiOS applications before deactivating local licenses or logging onto the License Manager.

After starting the ISD License Manager the activated modules will be highlighted in a different colour.

Click the Deactivate button to revoke the activation of the modules.

A selection is not possible, as you need to deactivate all modules, no matter whether local licenses or network
licenses. The deactivation process must not be disrupted, e.g. by a logout or the closing of ISD License Manager!

After successful deactivation the following message will be displayed.
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Trial Licenses
If you select Display trial licenses after login, you will be also shown, besides all trial licenses with a limited period of
validity, all purchasable licenses which are not simultaneously available as trial licenses.

Reconstruction of Licenses
As all licenses are stored on the ISD Server, you can, in case of an interrupted connection or an accidental deletion
of licenses, restore all licenses by logging in with your Entitlement ID. The restoring will only function if the hardware
was not changed (see Deactivate Licenses).

Notes on the Use of Mobile Computers (Laptops)
If you use a computer with WLAN card, Please make sure that the WLAN card is either always switched on, or
always switched off.
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Commuter Licenses
Commuter licenses enable you to use network licenses even if the workstation is not connected to the Server. There
are two ways of receiving commuter licenses:

n Checking Out Commuter Licenses, with Network Connection

n Checking Out Commuter Licenses, without Network Connection

Checking Out Commuter Licenses, with Network Connection
Start the ISD License Manager (while a connection to the Server still exists). Switch to the Commuter License tab.

If you have set the system environment variable LSFORCEHOST, the entered License Server will be displayed as the
preselected server upon start. Use the Search network button to automatically search for License Servers.

Expand the tree structure of the found Server by a click on the “+”-sign. The result looks as follows:
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Select the required licenses by activating the corresponding checkboxes on the left hand side.
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On the right hand side, information on the selected license is displayed.

In the Commuter license: Validity in days field, you enter the number of days that you want the commuter licenses
to remain checked out from the Server. The maximum number of days is 60. By default (or if a “0” is entered), the
value is set to 1.

For reasons of safety you should check out the licenses only for the required period! If a commuter license is lost,
e.g. because of theft or a defect of the client computer, the license on the Server cannot be used any more before
expiry of this date.

After entering the expiry date for the commuter licenses, click the Update licenses button. The Commuter licenses
are checked out from the Server.

All selected licenses are now checked out from the Server and you possess all rights on your computer for the spe-
cified validity period for the commuter licenses. This means that you are enabled to work network-independent. The
checked out licenses are no longer available to the other computers on the network.
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You can however also return the commuter licenses before their expiry date. To do this, you need to connect to the
Server, deactivate the checkboxes on the left and click the Update licenses button. All licenses are now made avail-
able on the Server and locked on your computer, i.e. you can now only use HELiOS if there is a connection to the
License Server. The licenses made available again can now also be used from other workstations.

Checking Out Commuter Licenses, without Network Connection
Commuter licenses can also be drawn from the License Server without an existing network connection. For this
Administrator rights are required.

Commuter licenses checked out in this way cannot be returned to the License Server! This means that the com-
muter licenses that have been checked out from the Server are only (automatically) made available again after their
expiry date.

Several steps are required for checking out without network connection - by the Administrator having a network con-
nection to the License Server, as well as by the Client (that is, your laptop) having no network connection to the
License Server.

As long as commuter licenses are checked out in this way, it is not possible to update the network licenses on the
server. The same applies when buying new modules/licenses and changing the configuration.

The Client starts the ISD License Manager tool, switches to the Remote Locking Code tab.
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Then, the Client sends the generated character set to the Administrator (via E-mail or over the phone).

The Administrator starts the ISD License Manager and switches to the Commuter License tab.
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The License Server will be selected, and the required licenses (modules) are activated in the left window. In the Com-
muter license: Validity in days field, you enter the number of days that you want the commuter licenses to remain
checked out from the Server. The maximum number of days is 60. By default (or if a “0” is entered), the value is set
to 1. To checkout a remote commuter license the administrator now needs to activate the Check out authorisation
for remote computer checkbox . Administrator rights are required for this.

A click on the Update licenses button opens a new dialogue window, in which the administrator enters the char-
acter set received from the Client

After selecting OK, another dialogue opens.

Here the Administrator enters the target path and the file name for the licenses to be swapped out. Make sure that a
unique file name is used, for example, by including in the file name the host name of the remote computer and the
expiry date.

Click OK to check out the commuter licenses from the License Server and swap them out to a file, e.g.
RemoteLicCode.lic.

After receiving the file with the commuter licenses, the Client starts the ISD License Manager again and activates
the Install Remote Authorisation Code tab.
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Now the Client can install the received commuter licenses directly via file selection or via copying of the file contents.
Click the Install Remote Commuter License button to install the Commuter Licenses on the Client.

After successful installation, the Client must switch to the Standalone License Info tab.
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To update, the Client must click on the Activate button. The information which licenses are installed locally on the
computer will then be provided to the Client.
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License Configuration
Some cases may require the use of only certain specific licences on a computer. Example: On the License Server
HELiOS Office and HELiOS Engineer licenses are available. On one Client, HELiOS is to be started with a HELiOS
Office license; on another Client, with a HELiOS Engineer license. If the selected license is no longer available, an
application start is no longer possible.

If there are several basic modules in a standalone (workstation) license (to which also the Commuter Licenses
belong), it is mandatory to make a pre-configuration and save it as workstation configuration. If no pre-configuration
is possible, the HELiOS configuration tab will be displayed before the start of HELiOS. If the selected configuration
does not match the available licenses, a warning message will be issued, with a list of available licenses. After this,
the configuration selection will be displayed again.

On the HELiOS Configuration of the ISD License Manager tool you have the option to save a workstation or user con-
figuration for individual Clients.

n Save as workstation configuration: This configuration will be saved for all users of this computer. When HELiOS
is started, the selection window is no longer displayed (administrator rights are required for this).

n Save as user configuration: This configuration is only saved for the current user. When HELiOS is started, the
selection window with the saved configuration is always displayed.

These license configurations apply to network licenses and standalone (workstation) licenses.
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Server Monitor
With the ISD License Manager tab Server Monitor you are allowed (as far as you are able to execute ISD License
Manager) to view detailed information as follows:

n Listing of available modules with module description (e.g. “Element Installation”). Relevant is the License Server
which the user is connected with.

n Apart from the module description, the maximum amount of available licenses as well as allocated licenses is
displayed.

n You can open up the available modules and here the users using the respective license are displayed.

n The listing of users using a license also shows which user is connected with the License Server and which user
uses a Commuter License.

By listing the licenses you can easily see who blocks licenses and, for example, easily speak to them in case if you
need a license.

In the installation program, the tab Server Monitor is activated by clicking on the option Activate license admin-
istration tools.
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Theft of a Workstation
The user is responsible for appropriately insuring the HELiOS workstations against theft. If desired, we can tell you
the reinstatement value of your software. If a workstation is stolen, you will need a new license. In such cases, please
send us the police report of the theft first. We will then provide you with a license for a limited period of time, and sub-
mit an offer for a new license to you. The ISD will send you the new license after clarification of the case with your
insurance and receipt of your payment for the license fee.
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First Steps
n HELiOS at a Glance

n Start HELiOS

n What's New in Version 2022?

HELiOS

Installation Notes 131 / 146



HELiOS at a Glance
On the way to the finished product, invested time, spent costs and product quality can only be optimised if all depart-
ments of a company cooperate efficiently. This requires a well-structured and efficient exchange of information
between the parties involved in the production process - from Manufacturing, Purchasing and Service to Marketing
and Sales.

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-free gathering, management
and distribution of the data required for the production process chain. Once saved, these data can be re-used within
the entire company and for the complete product life cycle. HELiOS manages and controls all process cycles by reg-
ulating and monitoring the processing and transfer of these data.

By combining Product, Process and Peripherals Management in a single system, HELiOS becomes the central
“knowledge reservoir” of your company and guarantees transparent and secure processes.

HELiOS can be interfaced with your CAD system or used as a stand-alone system, the so-called HELiOS Desktop -
either as a single workstation or at different locations.

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific requirements.
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Start HELiOS
Start the HELiOS Desktop by double-clicking on the HELiOS.EXE file in the \HELiOS\exe directory or via the HELiOS

icon on the Desktop of your computer.

Default setting is the project-independent start. Please note that the list view in the right-hand window will not be
shown when you start HELiOS Desktop for the first time. Select a project first and display the list view via View and
then Lists.

If you have not closed HELiOS correctly during your last session, you will receive an error message from the Vault
Server.

To make the best possible use of the numerous new features and enhancements offered by HELiOS, check out the
videos explaining the new and changed HELiOS functionalities. From now on we will provide you with such videos
with each Major Release and Service Pack to keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. Please note that you can configure the display
of the News window at the bottom left. We recommend using the Show most recent news option to ensure that you
will never miss any news about HELiOS. If you selected the Show never option, you can call the News window again

at any time and change the display option by clicking on the symbol at the top right and selecting Show news.

Login
The HELiOS User Management is based on the User Management of Windows. If several users are registered with
the same Windows User Name in EDBSETUP, a login mask will appear when starting HELiOS Desktop.

Name and active group enable the user to login with the rights guaranteed by the User Management.
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If you select a project from the Active project drop-down list, this project will be opened after starting HELiOS
Desktop. If you select the project-independent setting, all documents will be displayed.

Start the HELiOS Desktop with Login.

To ensure that a specific project will be opened after starting HELiOS Desktop, you need to specify a Start Project.
On the Ribbon, activate the Tools tab, then select Options, activate in the dialogue the General tab and choose a
start project.

Switch user

Use the Switch user function for a renewed login while working with HELiOS Desktop, e.g. to work with dif-
ferent rights without having to exit the program.

Activate the Switch user function via the QuickAccess toolbar. Select a different user. Change the active pro-
ject if required and confirm the new settings with Login.
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What's New in Version 2022?
An extensive overview of all changes and enhancements of HiCAD 2022 can be found in the What's new? topic of

the Help. You can also click on the button in the Help.

An overview in PDF format will be displayed if you click on the button in the Download area of the ISD
Wiki.
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How to Use the Help
The Online Help provides you with information, descriptions and examples on all functions and techniques which
are available in HELiOS.

Please note:

The scope of available functions may vary, depending on the configuration of your HELiOS product. This means
that some of the functions described in the Online Help may not be available in your version.

The Help is available both locally (status of the installation DVD) and on the Internet (regularly updated) at help.is-
dgroup.com. Both versions of the Help can be called from HELiOS.

Click on the button to call the HELiOS Help.

Choose > HELiOS Options to determine which version of the Help will be used.

Please note:

If you move the cursor over a function on the Ribbon and press the F1 key, the Help page for that specific func-
tion will be displayed.

To be able to use the Internet version of the Help, you need to register for the ISD’s new company Wiki once. This
will not only give you access to the new Help, but also provide you with many other information which will be made
available shortly in the ISD Wiki (Forum, Download area etc.)

Click Sign up in the login window of the Online Help to register. If you have already been registered, enter your
access data and click Login to get directly to the start page of the Online Help.

136 / 146 Installation Notes

How to Use the Help

https://help.isdgroup.com/
https://help.isdgroup.com/


After clicking Sign up in the Login window of the Online Help, enter the data required for the ISD Wiki in the dialogue
window. Confirm the security prompt and click the Sign up button.
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After successful registration the dashboard of the ISD Wiki will be displayed. A message indicates whether you have
been authenticated as an ISD customer.

If you could be identified as an ISD customer, you can now directly launch the Online Help using your registration
data.

If you could not be identified as an ISD customer, please perform the steps described in the message.

Important:

By default the Online Help has been selected after installation. If you prefer using the local Help, start the Install-
ation Wizard again and click on the HELiOS Help button.
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Hotline
Even after implementation, the support team of the ISD ensures competent support of their customers. Besides sup-
port over the phone, all current means of communication such as Fax, E-mail and Internet can be used. If any prob-
lems could not be solved in this way, our staff in all our offices will be there to help you at your company if required.

Germany Netherlands Austria Switzerland

Phone +49 (0)231 9793-
166

+31 (0)73 6153-
888

+43 (0)732 21 04
22-28

+41 (0)32 624 13-
47

E-Mail support@isdgroup.com

Service
hours

From Monday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

FromMonday to Fri-
day:
between 8:00 am
and 5:00 pm

FromMonday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

FromMonday to
Thursday:
between 8:00 am
and 5:00 pm

On Friday:
between 8:00 am
and 3:00 pm

If all lines are busy, a voice mail system will be activated, allowing you to leave a message. Our staff will call you back
as soon as possible. If a line becomes available during the recording of your message, your call will be accepted
immediately. It is our ambition to solve your problems as quickly as possible and let you have the solution via phone
or E-mail. A problem diagnosis will be made on the spot, and the existing problem will be dealt with and eliminated
as fast as possible.

In cases where your problem cannot be solved immediately, we will call you back after analyzing the situation.
Depending on the level of difficulty our Hotline will also bring in the Development department.
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Copyright
© 2011-2022 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used
or copied in accordance with the terms of the license. The contents of this User Guide solely serve the purpose of
information; it may be modified without prior notice and may not be regarded as binding for the ISD Software und
Systeme GmbH. The ISD Software und Systeme GmbH does not assume any responsibility for the correctness or
accuracy of the information provided in this document. No part of this document may be reproduced, saved to data-
bases or transferred in any other form without prior written permission by the ISD Software und Systeme GmbH,
unless expressly allowed by virtue of the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.

Sentinel® RMS and EMS

The license management portion of this Licensee Application is based upon one or more of the following copyrights:

n Sentinel®RMS, © 2009-2022 Thales Group. All rights reserved.

n Sentinel®EMS, © 2009-2022 Thales Group. All rights reserved.

Sentinel® is a registered trademark of the Thales Group.

PDF3D®

PDF3D®, © 2003-2022 Visual Technology Services Ltd. All rights reserved.

PDF3D® is a registered trademark of Visual Technology Services Ltd.

Protocol Buffer

Copyright 2008, Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the fol-
lowing conditions are met:

n Redistributions of source code must retain the above copyright notice, this list of conditions and the following dis-
claimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when generating it. This
code is not standalone and requires a support library to be linked with it. This support library is itself covered by the
above license.
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FreeType

Portions of this software are copyright 2018 The FreeType Project (www.freetype.org). All rights reserved.

Autofac, Copyright © 2022 Autofac Project

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this
permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Castle.Core, Copyright © 2004-2022 Castle Project

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required
by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the spe-
cific language governing permissions and limitations under the License.

ngx-extended-pdf-viewer, Copyright © 2008-2022 by James Boyle. All Rights Reserved.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required
by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the spe-
cific language governing permissions and limitations under the License.

Apache log4net, Copyright © 2004-2022 The Apache Software Foundation

This product includes software developed at The Apache Software Foundation (http://www.apache.org/). Licensed
under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by
applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the spe-
cific language governing permissions and limitations under the License.

NHibernate, Copyright © The NHibernate Project

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General
Public License as published by the Free Software Foundation (version 2.1). This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should
have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Soft-
ware Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.
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Fluent NHibernate, Copyright © 2008-2022, James Gregory and contributors

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

n Redistributions of source code must retain the above copyright notice, this list of conditions and the following dis-
claimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name of James Gregory nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Mesa Gallium, Copyright (C) 1999-2007 Brian Paul. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

ZLib, Copyright (C) 1995-2017 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter
it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software.
If you use this software in a product, an acknowledgment in the product documentation would be appreciated
but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly, jloup@gzip.org
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Mark Adler, madler@alumni.caltech.edu

ZStandard, Copyright (c) 2016-present, Facebook, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the fol-
lowing conditions are met:

n Redistributions of source code must retain the above copyright notice, this list of conditions and the following dis-
claimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name Facebook nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Angular, Copyright © 2010-2022 Google LLC.

Licensed under the MIT License.

See http://angular.io/license for details.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

PrimeNG, Copyright © 2016-2022 PrimeTek

Licensed under the MIT License.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

IdentityServer

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required
by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the spe-
cific language governing permissions and limitations under the License.
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Legal notes

© 2022 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in accordance with
the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be modified without prior notice and may
not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not assume any responsibility
for the correctness or accuracy of the information provided in this document. No part of this document may be reproduced, saved to databases
or transferred in any other form without prior written permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of
the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.
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Germany

Headquarter Dortmund
ISD Software und Systeme GmbH
Hauert 4
D-44227 Dortmund
Tel. +49 231 9793-0
info@isdgroup.de

Sales office Berlin
ISD Software und Systeme GmbH
Paradiesstraße 208a
D-12526 Berlin
Tel. +49 30 634178-0
berlin@isdgroup.de

Sales office Hamburg
ISD Software und Systeme GmbH
Strawinskystraße 2
D-25337 Elmshorn
Tel. +49 4121 740980
hamburg@isdgroup.de

Sales office Hanover
ISD Software und Systeme GmbH
Hamburger Allee 24
D-30161 Hanover
Tel. +49 511 616803-40
hannover@isdgroup.de

Sales office Nuremberg
ISD Software und Systeme GmbH
Nordostpark 7
D-90411 Nuremberg
Tel. +49 911 95173-0
nuernberg@isdgroup.de

Sales office Ulm
ISD Software und Systeme GmbH
Wilhelmstraße 25
D-89073 Ulm
Tel. +49 731 96855-0
ulm@isdgroup.de

International

ISD Austria
ISD Software und Systeme GmbH
Hafenstraße 47-51
A-4020 Linz
Tel. +43 732 21 04 22-0
info@isdgroup.at

ISD Benelux - Hertogenbosch
ISD Benelux B.V.
Het Zuiderkruis 33
NL-5215 MV ‘s-Hertogenbosch
Tel. +31 73 6153-888
info@isdgroup.nl

ISD Benelux - Zwolle
ISD Benelux B.V.
Grote Voort 293A
NL-8041 BL Zwolle
Tel. +31 73 6153-888
info@isdgroup.nl

ISD France
ISD Group France SAS
10 -12 Boulevard Vivier Merle
F-69393 Lyon
Tel. +33 6 73 72 04 67
info@isdgroup.fr

ISD Switzerland
ISD Software und Systeme AG
Rosenweg 2
CH-4500 Solothurn
Tel. +41 32 624 13-40
info@isdgroup.ch

ISD Switzerland
ISD Software und Systeme AG
Rte du Jura 37 A, 4. Étage
CH-1700 Fribourg
Tel. +41 79 803 51 51
info@isdgroup.ch

ISD USA - North Carolina
ISD Group USA Inc.
20808 N Main Street, Suite 101
USA-Cornelius NC 28031
Tel. +1 770 349 6321
info@isdgroup.us

www.isdgroup.com

ISD USA - Georgia
ISD Group USA Inc.
5126 South Royal Atlanta Drive
USA-Tucker GA 30084
Tel. +1 770 349 6321
info@isdgroup.us
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